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Supply 
The Supply User Manual explains how to use the Supply module to issue, return, transfer and receive 
supplies. Information in Supply may come from other I-Suite modules, including: 
  

• Resources 

• Demob 

• Incident Action Plan (IAP) 

• Time 

• Cost 
  
Topics in this guide include the following: 
  

• Common Features (See Page 5) 

• Selecting Supply Options (See Page 9)  

• Receive Supply Items (See Page 11) 

• Issue Supply Items (See Page 18) 

• Issue Returns (See Page 24) 

• Release Supply Items (See Page 28) 

• Add / Edit Supply Items (See Page 35) 

• Add / Edit Locations (See Page 39) 

• Transfer (at Incident) (See Page 43) 

• Supply Inventory (See Page 46) 

• Advanced Search (See Page 51) 

• Supply Reports (See Page 52) 

• View Supply History 
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Common Features 
This section describes the menus and toolbars available in the Supply module. 

Menus 

The following drop-down menus display at the top of the I-Suite windows:  
  

File Menu 
The following options are available in the File menu in all modules: 
  

• Open Database - Opens an incident database in I-Suite. 

• Print - Prints the grid in the open module or a report selected on the Reports 
window. 

  

The Print option is not available in the Database Admin module. 

  

• Refresh Data - Refreshes the data on your window. 

• Exit - Closes the I-Suite application. 
  

Modules Menu 
The following options are available in the Modules menu: 
  

• Database Admin - Opens the Database Admin Module. 

• Data Admin - Opens the Data Admin Module. 

• Resources - Opens the Resources Module. 

• Cost - Opens the Cost Module. 

• Supply - Opens the Supply Module. 

• IAP - Opens the Incident Action Plan Module. 

• Demob - Opens the Demob Module. 

• Time - Opens the Time Module. 

• Injury/Illness - Opens the Injury/Illness Module. 
  

Filters Menu 
Select an option from the Filters drop-down menu to filter the Resources grid by:  
  

• Aircraft  

• Crews  

• Equipment  

• Overhead  

• All  
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• All Personnel  
  
  

Reports Menu 
Select an option from the Reports menu to print the following types of reports: 
  

• Cost Reports  

• Demob Reports  

• Plans Reports  

• Supply Reports  

• Time Reports  

• Custom Reports  

• Injury/Illness Reports 
  

Tools Menu 
The following options are available in the Tools menu in all modules: 
  

• Options - Define the settings for the different modules in I-Suite. 
  

The settings you can change in Options depends on the permissions that are assigned to you in the I-
Suite system. 

  

• Quick Stats - Quickly view Stats in the I-Suite system. 

• Change Password - Change your I-Suite password. 
  
  

Help Menu 
The following options are available in the Help menu: 
  

• I-Suite Help - Opens Help information for the I-Suite application. 

• About - Displays version information for I-Suite. 

• Support - Displays contact information for the HelpDesk. 
  
  

Supply Menu 
The Supply menu only displays when you are in the Supply Module. The following options are available 
in this menu: 
  

• Release (Permanent) - Permanently releases supply items to another location, 
such as a cache or another incident. 

• Add/Edit Location - Adds or edits a location. 

• Add/Edit Supply Items - Adds or edits a Supply item. 

• Transfer (At Incident) - Transfers a Supply item from one resource to another 

• Import Shipment --Import Supply shipment. 

• Inventory - Allows the user to manually change inventory counts. 
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Toolbars 

The following toolbars display at the top of the I-Suite windows: 
  

Main Toolbar 
The Main toolbar contains two separate types of buttons: 
  

Module Buttons 
The Module buttons open modules in the I-Suite system. These buttons are located on the left side of 
the Main toolbar. The following example identifies the buttons and the modules that they open: 

  

 
  

Action Buttons 
The Action buttons perform an action in one of the I-Suite modules. These buttons are located on the 
right side of the Main toolbar. The following example identifies the buttons and the action that occurs: 

  

 

Filter Toolbar 
The Filter toolbar displays beneath the Main toolbar. Click the buttons in this toolbar to filter the 
information in the Resources grid. The following example identifies the buttons in this toolbar and the 
resources that display in the grid when you click the buttons: 
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Supply Toolbar 
The Supply toolbar displays to the right of the Filter toolbar when you are in the Supply module. The 
following example identifies the buttons in this toolbar: 
  

 
  

• Issue - Issue supply items. 

• Issue Returns - Return supplies issued to a resource or location. 

• Receive - Receive supply items. 

• Import Shipment -- Import supply shipment 

• View History - View a history of supply items that were issued. 

• Add/Edit Location - Add or edit locations that are either internal or external to the 
incident. 

• Add Supply Item - Add items to the Supply list. 

• Incident Card -- Links supply card to a resource 

• Issue Report -- Report of currently assigned supplies 
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Selecting Supply Options 

Follow the steps in this section to select options for the Supply area of the I-Suite system: 
  

1. From the Tools drop-down menu, select Options to open the Options window.  

2. Click the Supply tab to select it. 

 
  

3. From the Incident drop-down list, select the incident to which the supply options 
apply. 

4. Under Supply Address, enter the supply address, including Address 1, Address 
2, City, State, Zip Code and Phone Number. 

5. If you want to track the supply inventory, click to check the Track Inventory 
checkbox.  
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6. When you have made all of your changes, click the Save button to save the 
changes. Click the OK button to close the Options window.  
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Receive Supply Items 
This unit explains how to receive supplies. 
  

If you are using the Track Inventory feature, it is a good practice to Receive all items before issuing 
them to resources. If you do not Receive the items, the inventory counts may not be correct. 
 
If you are NOT using the Track Inventory feature, you do not need to Receive items before issuing 
them. 

  

Filtering Supply Items  

Follow these steps to filter the supply items in the Item To Receive grid: 
  

1. Click the Supply button to open the Supply module. 

2. In the Supply Toolbar, click the Receive button to open the Receive window. 
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3. Click one of the following buttons to filter the list of supplies: 

• All - Displays all supply items 

• Non NFES - Only displays supply items without NFES numbers 

• Only NFES - Only displays supply items with NFES numbers 

• Track - Only displays trackable supply items 

  

Receiving Supplies 

Follow the instructions in this section to receive supplies from a cache or other location outside of the 
incident: 
  

Only those supply items defined in Add Supply Item, display in the Item to Receive grid.  

  

1. Click the Supply button to open the Supply module. 

2. Click the Receive button to open the Receive Supply window. 

3. From the From Location drop-down list, select the location from which you are 
receiving the supply item.  
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If you do not select a location before receiving a supply item, a message displays indicating that a 
location was not selected. Click the Yes button to receive the item without selecting a location. Click the 
No button to cancel the receive procedure and select a location. 

  

4. In the Item to Receive grid, click the item you want to receive. 

5. Click the Receive Item button. A Receive Supply Item window displays.  

 
  

6. Enter the Quantity to Receive. 

7. Enter the Property # assigned to the item, if applicable. 

If you enter a Property # for the item, the Quantity to Receive is automatically set to 1 and you cannot 
change it. 

  

8. Enter the Serial # assigned to the item, if applicable. 

9. Enter an Additional # assigned to the item, if applicable. 

10. In the Remarks box, type any remarks that apply to the receive item transaction. 
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11. Click the Save button to save the supply item to the Items Being Received grid. 

12. Repeat steps 4 - 11 for each item you are receiving from the selected location. 

If your team is part of the Supply Pilot, you can scan either the bar code in the Smart Book for the item 
you are receiving or the NFES Bar Code on the item. When you scan the bar code, the system 
automatically displays the item in the Items Being Received grid on the screen. If there are multiple 
quantities you are receiving, scan the bar code multiple times to increase the quantity amount. 

  

13. When all items you are receiving are listed in the Items Being Received grid, 
click the Save button to complete the Receive procedure. 

  

Using Quick Receive Items 

Follow the steps in this section to quickly receive supply items: 
  

To use this feature, you must know the NFES # of each item. The preceding 0's (zeroes) do not need to 
be entered. For example, "000154" can be entered as "154." 

  

1. Click the Supply button to open the Supply module. 

2. Click the Receive button to open the Supply - Receive window. 

3. Click the Quick Receive button to open the Quick Receive Item(s) window. 
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4. In the NFES # box, enter the NFES number for the supply item you are receiving. 

5. If you are receiving more than one supply item with the same NFES number, click 
to check the Do not clear NFES # checkbox. This leaves the NFES number in the 
NFES# box after you click the Save button. 

6. In the Quantity to Receive box, enter the total number being received. 

7. If applicable, enter a property number for the item in the Property # box. 

If you enter a Property # for the item, the Quantity to Receive is automatically set to 1 and you cannot 
change it. 

  

8. Click the Save button. The item displays in the Items Being Received grid and 
the Quick Receive Item(s) window remains open. You can then quickly enter 
another item. 

9. Repeat steps 4 - 8 for each item you are receiving from the selected location. 
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10. When you have finished receiving items, click the Cancel button to close the 
Quick Receive Item(s) window. 

11. Click the Save button to finish receiving the items into Supply. 

  

Remove/Change Item Being Received 

Follow the steps in this section to either change the quantity for an item listed in the Items Being 
Received grid or remove the item from the grid: 
  

1. In the Items Being Received grid, click the item you want to edit. 

2. Click the Remove/Change Receive button to open the Remove/Change Item 
window. 

 
  

3. In the Quantity to Receive box, enter the total number being received. 

To remove the item, enter 0 (zero) in the Quantity to Receive box. 
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4. In the Property # box, enter a property number, if applicable. 

5. In the Serial # box, enter a serial number, if applicable. 

6. In the Additional # box, enter an additional number, if applicable. 

7. In the Remarks box, enter any remarks applicable to removing or changing the 
item. 

8. Click the Save button to change the quantity. Click the Remove button to remove 
the item. 
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Issue Supply Items 
Follow the steps in this section to issue supply items: 
  
  

1. Click the Supply button to open the Supply module or choose Modules and then 
Supply from the menu. 

2. Click the Issue button from the toolbar to open the Supply-Issue window. 
NOTE:  If you are issuing items in the ISuite system that have already been 
issued to a resource on an earlier date, you must change the Date Issued field to 
reflect the actual date the items were issued. The Date Issued date defaults to the 
system date. (Example: Issuing items at an Incident before the computer systems 
were up) 
 

 

3. Do one or both of the following: 

• In the Resources grid, click the resource to which supplies are being 
issued. 
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• From the Location drop-down list, select the location to which the 
supplies are being issued. 

To unselect a Resource or unselect a Location, click the Clear Selection button. 

  

If your team is part of the Supply Pilot, you can scan a resource's incident card to select that resource 
when issuing supplies. 

  

4. Under Issue Type, click to select the type of issue: Standard Issue, Exchange or 
Replacement.  

5. Under Items for Issue, click to select the item being issued. If you wish to see 
only those items that are currently at the Incident, click the Items at Incident 
checkbox.  
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6. Click the Select Item button to open the Issue Items window. 
 

 

7. In the Quantity to Issue box, enter the quantity of the item to issue. 

8. In the Remarks box, enter any remarks that apply to the item being issued. 

9. To add the Item(s) to the Items Issued grid, click the Save button. 

10. To add another Item to the Items Issued grid, repeat steps 4 - 8. When you are 
finished, click the Cancel button to close the Issue Items window. 

You can only issue items to one Resource or Location at a time. 

  

If your team is part of the Supply Pilot, you can scan either the bar code for the item in the Smart Book 
or the NFES Bar Code on the item. When you scan the bar code, the system automatically displays the 
item in the Items Issued grid on the screen. If there are multiple quantities you are issuing, scan the bar 
code multiple times to increase the quantity amount. 

  

10. When all items to be issued are in the Items Issued grid, click the Save Item(s) 
button to issue the items to the selected location or resource. 

If one or more of the items had a Property Number defined, a Waybill for the item displays in a Preview 
window. Click the Print Report button to print the Waybill. If the Waybill does not display, click the 
Preview/Print Waybill button. 
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Remove/Change Items Issued 

To remove or change the quantity of an item on the Items Issued grid, follow these steps: 
  

1. Click to select the item you want to remove or change.  

2. Then click the Remove/Change Issue button. A Remove Item(s) window 
displays: 
 

 

3. In the Correct Quantity to Issue box, enter the quantity of the item to issue. 

To remove the item from the Item Issued grid, enter 0 (zero) in the Correct Quantity to Issue box. 

  

4. Click the Save button to change the quantity or remove the item. 

  

Using Quick Issue 

Use the Quick Issue option to quickly issue supply items to resources or locations. 
  

To use this feature, you must know the NFES # of each item. The preceding 0's (zeroes) do not need to 
be entered. For example, "000154" can be entered as "154." 

  

1. On the Supply - Issue window, select the Resource or Location to Issue To. 
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2. Under Items for Issue, click the Quick Issue button. The Quick Issue Item(s) 
window displays: 
 

 

3. In the NFES # to Issue box, enter the appropriate NFES number.  

4. If you are issuing more than one supply item with the same NFES number, click to 
check the Do not clear NFES # checkbox. This leaves the NFES number in the 
NFES# box after you click the Save button. 

5. If applicable, select a property number for the item from the Property Number 
drop-down list.  

6. Enter the Quantity to Issue.  

If a property number was assigned to the item, you cannot enter a quantity greater than 1. 

  

7. Enter any comments about the item being issued in the Remarks box. 

8. Click the Save button to save the items to the Item Issued grid. 

The Quick Issue Item(s) window remains open after you save the new item count. This enables you to 
quickly add issue another item. 
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9. To enter additional items, repeat the steps 3 - 8. 

10. After all of the items have been added to the Item Issued grid, click the Cancel 
button, to close the Quick Issue Item(s) window. 

11. To finish issuing, click the Save Item(s) button next to the Items Issued grid. 
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Issue Returns 
Follow the steps in this section to return supplies issued to a resource or location: 
  

Use the filter buttons in the Filter toolbar to filter the grid and make it easier to find a Resource or Item.  

  

Return Items 

Follow the steps in this section to return items by selecting a Resource or a Location to which the items 
were issued: 
  

1. Click the Supply button to open the Supply module. 

2. On the Supply Toolbar, click the Issue Returns button to open the Issue 
Returns window: 
 

 

3. In the upper grid, click to select the appropriate Resource, or select a location 
from the Location drop-down list. You can also use one of the Alternative 
Methods to populate the Items Issued grid (See Alternative Methods to Populate 
the Items Issued grid on Page 27). 

If your team is part of the Supply Pilot, you can scan a resource's incident card to select that resource 
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when returning supplies. 

  

Once a Resource or Location is selected, all items still issued to that Resource or Location will display 
in the Items Issued grid. 

  

4. Under Items Issued, click to select the Item being returned. 

  

5. Click the Return Items button to open the Return Item window. 

  

If your team is part of the Supply Pilot, you can scan either the bar code in the Smart Book or the NFES 
Bar Code on the item to initiate the return process for that item. When you scan the bar code, the Return 
Item window opens with that item selected. 

  

 
  

6. In the Not Ready For Issue box, enter the total quantity being returned that is not 
ready to issue.  

7. In the Ready for Issue box, enter the total quantity being returned that is ready for 
issue.  

8. Click the Save button to return the item. 
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Return by Property # 

Follow the steps in this section to return an item by that item's property number, regardless of the 
resource or location to which the item is issued. 
  

1. Click the Supply button to open the Supply module. 

2. On the Supply Toolbar, click the Issue Returns button to open the Issue 
Returns window. 

3. Click the Return by Property # button that is located on the bottom right side of 
the window. A Return by Property Number window opens: 

 
  

4. Select the property number assigned to the item you are returning from the 
Property Number drop-down list. 

5. Identify whether the item is Ready For Issue or Not Ready For Issue. 
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Alternative Methods to Populate the Items Issued grid 

1. To display items issued to a Resource only, select the Resources radio button 
and click the Issued Items button 

2. To display items issued to a Location only, select the Locations radio button and 
click the Issued Items button. 

3. To display items currently issued to Resources and Locations, click the Both radio 
button and click the Issued Items button. 

4. To display all supply items currently listed in the supply catalog, click the Catalog 
Items button. Items will be displayed in the Items Issued grid. 
 

This will display only non-trackable items. 
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Release Supply Items 
Follow the steps in this section to release supply items: 
  

Use this feature to permanently release supply items to another location, such as a cache or another 
incident.  

  

1. Click the Supply button to open the Supply module. 

2. From the Supply menu, select Release (Permanent) to open the Release 
window:
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3. Select Add Waybill to create a new Waybill to assign supplies to. 

 

4.  The Supply Waybill - Add window will open.  

 

5. Enter the information that will appear on the Waybill. Fields marked with an 
asterisk (*) are required fields. When all information has been entered click Save. 
At this point you may add another Waybill or click Close to go back to the main 
screen.  
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6. The Waybill(s) now shows in the Release grid. 
 

  

7. Next to the middle grid is the Show Items option. You can select to see All items 
or items Only at Incident. 

8. In the middle grid, click to select the Supply Item to release. Then click the Select 
Item button to open the Release Items window. You can also double click the 
supply item to open the Release Items window. 

If your team is part of the Supply Pilot, you can scan either the bar code in the Smart Book for the item 
you are releasing or the NFES Bar Code on the item. When you scan the bar code, the system 
automatically displays the item in the Items Released grid. 
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5. In the Quantity to Release box, type the total quantity to release.  

6. In the Remarks box, type any applicable remarks. 

7. Click the Save button to save the release information to the Items Released grid. 

8. Repeat the previous steps until all items to release are included in the Items 
Released grid, and then review the items for accuracy. 

 

9. To edit the items identified for release, click the Item and then click the 
Remove/Change Release button next to the lower grid.  

10. The Remove/Change Release window will open. Make the appropriate edits, or 
click Remove to delete the item. Click Save to close the window and return to the 
main screen. 
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11. Click the Preview/Print Waybill button. The Finalize Waybill window will open. 

 
 

12. On the Finalize Waybill window there will be an option to Preview/Print Draft 
Waybill or Preview/Print Final Waybill. Select the appropriate option and click to 
Preview, Print or Cancel and return to the previous screen. If the Draft option is 
selected, the word DRAFT will appear on the Waybill, same with the Final option.  

13. Once the option to print the Final Waybill is selected a confirmation window will 
display. Once the Final Waybill is printed, it can no longer be edited.  

 

14. The Finalized Waybill will now show in the Release grid. 
 

 

  

Using Quick Release Items 

Follow the steps in this section to quickly release supply items: 
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To use this feature, you must know the NFES # of each item. The preceding 0's (zeroes) do not need to 
be entered. For example, "000154" can be entered as "154." 

  

1. In the Release grid on the Supply - Release window, click the waybill to which you 
are releasing the items. 

2. Click the Quick Release button to open the Quick Release Item(s) window. 

 
  

3. In theNFES # to Release box, enter the appropriate NFES number.  

4. If you are issuing more than one supply item with the same NFES number, click to 
check the Do not clear NFES # checkbox. This leaves the NFES number in the 
NFES# box after you click the Save button.  

5. If applicable, select a property number for the item from the Property Number 
drop-down list.  

6. Enter the Quantity to Release.  

7. Enter any comments about the item being issued in the Remarks box.  

8. Click the Save button to save the items to the Items Released grid.  
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The Quick Issue Item(s) window remains open after you save the new item count. This enables you to 
quickly add issue another item. 

  

9. To enter additional items, repeat the steps 3 - 8.  

10. After all of the items have been added to the Item Issues grid, click the Cancel 
button, to close the Quick Release Item(s) window. 

  

Change/Remove Released Item 

If you need to change the quantity for a released item listed in the lower grid or remove it from the list, 
follow the steps in this section: 
  

1. Click to select the incorrect item, and then click the Remove/Change Release 
button. 

2. On the Release Item(s) window, change the quantity and remarks, as 
appropriate, and then click the Save button. To remove the item, click the 
Remove button. 
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Add / Edit Supply Items 
This section contains information on adding and editing supply items. 
  

Adding Supply Items 

Follow the steps in this section to add a Supply item to the I-Suite system: 
  

1. Use one of the following methods to open the Add Supply Item window: 

• From the Supply drop-down menu select the Add/Edit Supply Item option. 

• On the Receive window click the Add Supply Item(s) button. 

• On the Issue window click the Add Supply Item(s) button. 

• On the Issue Returns window click the Add Supply Item(s) button. 

• On the Release window click the Add Supply Item(s) button. 

• On the Inventory window, click the Add Supply Item(s) button. 

2. On the Supply - Add Supply Item window, click the Add button. 
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3. In the Name box, type the name of the supply item. This information is required. 

4. In the Description box, type a description of the supply item. This information is required. 

5. In the NFES # box, type the National Fire Equipment System (NFES) number for 
the item. 

The NFES number you enter must be unique.  

  

6. From the Category drop-down list, select the category for the item. 

7. In the Property # box, type the property number assigned to the item. 

8. From the From Location drop-down list, select the location where the item 
originated. 

9. From the Supply Catalog Access drop-down list, select the departments who 
should have access to the item. The options include Supply Only, 
Communications Only, or All. 

If the user has Communications rights, they cannot assign Supply Only to an item. They can only 
assign Communications Only or All to the item. 

  

10. In the Cost box, type the cost of the item. 
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11. If the item is a rental, click to check the Rental Item checkbox. 

12. In the Qty On Hand box, type the total number of the item currently available at 
the incident. 

If a property number was assigned to the item, you cannot enter a quantity greater than 1. 

  

13. In the ReOrder Qty box, type the quantity at which the item should be re-ordered. 

14. From the Qty Per Container drop-down list, select the total quantity included in 
each container for the item. 

15. From the Unit of Issue drop-down list, select the unit at which the item is issued. 

16. If the item is a hazardous material, select the hazard type from the Hazardous 
drop-down list. 

17. Type the item's measurements in the, Weight-US (lbs), Weight-Metric (kgs), or 
Cubes (ft^3) box. 

18. In the Remarks box, type any applicable remarks for the item. 

19. To save the Supply Item, click the Save button. 

20. When you have finished adding all of the appropriate items, click the Close button 
to close the Supply - Add Supply Item window. 

  

Editing a Supply Item 

Follow the steps in this section to edit the information defined for a supply item:   
  

1. Use one of the following methods to open the Add Supply Item window: 

• From the Supply drop-down menu select the Add/Edit Supply Item option. 

• On the Receive window click the Add Supply Item(s) button. 

• On the Issue window click the Add Supply Item(s) button. 

• On the Issue Returns window click the Add Supply Item(s) button. 

• On the Release window click the Add Supply Item(s) button. 

• On the Inventory window, click the Add Supply Item(s) button. 

2. Click one of the following buttons to filter the Supply Item grid at the top of the 
window: 

• All - Displays all supply items. 
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• Non NFES - Displays supply items without an NFES number. 

• Only NFES - Displays only supply items with an NFES number. 

3. In the Supply Item grid at the top of the window, click to select the supply item 
you want to edit. The information for the item displays in the Edit Supply Item 
area at the bottom of the window. 

If your team is part of the Supply Pilot, you can scan either the bar code in the Smart Book for the item 
you are editing or the NFES Bar Code on the item. When you scan the bar code, the system 
automatically displays that supply item in the Edit Supply Item area at the bottom of the window. 

  

4. You can make changes to the following information: 

• Property # 

• From Location 

• Category 

• Supply Catalog Access 

• Qty On Hand 

• ReOrder Qty 

• Issue By Unit of Issue 

• Remarks 

5. To save your changes, click the Save button. 

6. When you have finished editing all appropriate items, click the Close button to 
close the Supply - Add Supply Item window. 

  



 

Chapter 9 

  

I-Suite Version 13.01.00 Supply 39 

Add / Edit Locations 
This section contains information on adding and editing locations.   
  

Adding a Location - Within an Incident 

Follow the steps in this section to add a location that is within an incident: 
  

1. Use one of the following methods to open the  Add Location window: 

• On the Receive window click the Add/Edit Location button. 

• On the Issue window click the Add/Edit Location button. 

• On the Release window click the Add/Edit Location button.  

2. On the Add Location window, click the Within Incident button, and then click the 
Add button. 

 
  

3. In the Location Name box, type the name of the location. The Location Name is 
required. 

4. In the Location Code box, type the code to assign to the location. The Location 
Code is required. 
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5. In the POC Name box, type the name of the point -of-contact at the location. 

6. In the POC Phone # box, type the telephone number for the point-of-contact. 

7. In the POC Email box, type the e-mail address for the point-of-contact. 

8. In the Latitude box, type the latitude for the location. 

9. In the Longitude box, type the longitude for the location. 

10. In the Remarks box, type any remarks applicable to the location. 

11. Click the Save button to save the location to the I-Suite system. 

12. Click the Close button to close the Add Location window. 

  

Editing a Location - Within an Incident 

Follow the steps in this section to edit a location that is within the incident: 
  

1. Use one of the following methods to open the  Add Location window: 

• On the Receive window click the Add/Edit Location button. 

• On the Issue window click the Add/Edit Location button. 

• On the Release window click the Add/Edit Location button.  

2. On the Add Location window, click the Within Incident button. 

3. Click the location you want to edit in the grid at the top of the window. 

4. You can make changes to the following information: 

• POC Name 

• POC Phone # 

• POC Email 

• Latitude 

• Longitude 

• Remarks 

5. Click the Save button to save your changes. 

6. Click the Close button to close the Add Location window. 
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Adding a Location - Outside an Incident  

Follow the steps in this section to add a location that is outside of an incident to the I-Suite system: 
  

1. Use one of the following methods to open the  Add Location window: 

• On the Receive window click the Add/Edit Location button. 

• On the Issue window click the Add/Edit Location button. 

• On the Release window click the Add/Edit Location button.  

2. On the Add Location window, click the Outside Incident button, and then click 
the Add button. 

 
  

3. In the Location Name box, type the name of the location. The Location Name is 
required. 

4. In the Location Code box, type the code to assign to the location. The Location 
Code is required. 

5. From the Location Type drop-down list, select one of the following location types: 

• B - Business Address 

• L - Local Cache Address 

• N - National Cache Address 

• R - Regional Cache Address 

5. In the Address 1, Address 2, City, State, and Zip boxes, type the location's 
address. 

6. In the POC Name box, type the name of the point-of-contact at the location. 
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7. In the POC Email box, type the e-mail address for the point-of-contact. 

8. In the POC Phone # box, type the telephone number for the point-of-contact. 

9. In the Fax Phone # box, type the fax number for the point-of-contact. 

10. In the Remarks box, type any remarks applicable to the location. 

11. To save the new Location, click the Save button. 

12. To close the Add Location window, click the Close button. 

  

Editing a Location - Outside an Incident 

Follow the steps in this section to edit a location that is outside of an incident: 
  

1. Use one of the following methods to open the  Add Location window: 

• On the Receive window click the Add/Edit Location button. 

• On the Issue window click the Add/Edit Location button. 

• On the Release window click the Add/Edit Location button.  

2. Click the Outside Incident button. Then click to select the location you want to 
edit in the grid at the top of the window. 

3. You can make changes to the following information: 

• POC Name 

• POC Email 

• POC Phone # 

• Fax Phone # 

• Remarks 

4. Click the Save button to save any changes you made. 

5. Click the Close button to close the Add Location window. 
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Transfer (at Incident) 
This section identifies how to transfer a supply item to another resource at an incident. This option helps 
track a supply item that was issued to a resource and then, subsequently, given to a different resource at 
the incident. 
  

1. Click the Supply button to open the Supply module. 

2. From the Supply drop-down menu, select the Transfer (at Incident) option to 
open the Supply - Transfer window. 

 
3. Select the resource or location to which the item is being transferred: 

a. To transfer to a resource, click the resource to which the item is being 
transferred in the Issue To grid.  
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b. To transfer to a location, rather than another resource, click the UnSelect 
Resource button and select a location from the Location drop-down list. 

3. In the Item Name grid, click the item that is being transferred. 

Only items that are Trackable and Issued to a resource are listed in the Item Name grid. Trackable 
items are those supply items with a Property Number defined. Property Numbers can be defined when 
the supply item is Added, Received or Issued. 

  

5. Click the Select Item button to open the Transfer Item window. 

 
  

6. In the Remarks area, type any remarks concerning the transfer. 

You can only enter Remarks on the Transfer Item window. The name of the item and the quantity being 
transferred are automatically defined, based on the information specified when it was initially issued. 

  

7. Click the Save button to save the transfer item to the Item Transferred grid. 

8. If there are multiple items being transferred to the selected person, repeat steps 4 
- 7 for each item. 

9. Click the Transfer Item(s) button to transfer the item(s) listed in the Items 
Transferred grid to the selected resource. 

10. When the Waybill displays in the Preview window, click the Print Report button 
to print the Waybill. 
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11. When the Print window displays, click the Print button to print the Waybill. 

  

Remove Transfer Item 

Follow the steps in this section to remove an item from the Items Transferred grid: 
  

1. Click the item you want to remove in the Items Transferred grid. 

2. Click the Remove Item button to open the Transfer Item window. 

3. Enter any applicable remarks in the Remarks box, and click the Save button. The 
item is removed from the Items Transferred grid. 
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Supply Inventory 
This section identifies the steps for tracking the supply inventory. 
  

When using the Supply Inventory option, it is a good practice to Receive all items into the Supply 
module before issuing them to resources. If you do not Receive the items into the Supply module, the 
inventory counts may not be correct. (See Receive Supply Items on Page 11) 

  
  

Manually Updating Inventory Counts 

Follow the steps in this section to update Inventory Counts in the Supply module based on a manual 
count: 
  

If you Issued items to resources before Receiving them into the Supply module, you can manually 
update the Inventory Counts by following the procedures outlined in this section. 

  

1. Click the Supply button to open the Supply module. 

2. From the Supply drop-down menu, select the Inventory option to open the 
Supply - Inventory window. 
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3. In the Items to Inventory grid, click the supply item that needs corrections made 

to the inventory count. 

4. Click the Correct Item Inventory button to open the Correct Item Inventory 
window. 

If your team is part of the Supply Pilot, you can scan either the bar code in the Smart Book for the 
inventory item or the NFES Bar Code on the item. When you scan the bar code, the system automatically 
opens the Correct Item Inventory window with the scanned inventory item selected. 
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5. In the Actual NRFI box, type the total number of items that are Not Ready For 
Issue. 

6. In the Actual RFI box, type the total number of items that are Ready For Issue. 

7. Click the Save button to save the counts to the Corrected Inventory Items grid. 

8. Repeat steps 3 - 7 for each supply item that needs corrections made to the 
inventory count. 

9. After all of the inventories that needed corrections have been added to the 
Corrected Inventory Items grid, click the Save button that displays on the right 
side of the window. 

  

Quick Adjust Inventory Item Counts 

Follow the steps in this section to quickly update Inventory counts in the Supply module: 
  

1. Click the Supply button to open the Supply module. 

2. From the Supply drop-down menu, select the Inventory option to open the 
Supply - Inventory window. 

3. Click the Quick Inventory button to open the Quick Adjust Inventory  window. 
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4. In the NFES box, type the NFES number for the item that needs corrections made 
to the inventory count. 

5. If appropriate, select a property number from the Property Number drop-down 
list. 

6. In the Actual NRFI box, type the total number of items that are Not Ready For 
Issue. 

7. In the Actual RFI box, type the total number of items that are Ready For Issue. 

If a property number was assigned to the item, you cannot enter a quantity greater than 1. 

  

8. Click the Save button to save the item counts to the Corrected Inventory Items 
grid. 

The Quick Adjust Inventory window remains open after you save the new item count. This enables you 
to quickly add another adjustment. 

  

9. Repeat steps 4 - 8 for each supply item that needs corrections made to the 
inventory counts. 
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10. After all of the inventories that needed corrections have been added to the 
Corrected Inventory Items grid, click the Cancel button to close the Quick 
Adjust Inventory window. 

11. Click the Save button that displays on the right side of the window to save the 
corrected inventory counts. 
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Advanced Search 
The Advanced Search function allows you to limit the grid so only those items with a defined term in their 
name or description display. Follow the instructions in this section to use the Advanced Search feature 
to search for supply items.  
  

The Advanced Search option is available on the Issue, Issue Returns, Receive, Transfer, Inventory and 
Release windows. 

  

1. In the Advanced Search box on the right side of the window, enter the term for 
which you want to search. 

 
2. Click the Search Name/Desc button. The grid now only contains those items with 

the search term in either the name or the description. For example, if you entered 
AXE as your search term, only those items with AXE in the name or description 
would display in the grid. 

3. To clear the filter and display all items in the grid, click the Clear Advanced 
Search button. 
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Supply Reports 
Follow the steps in this section to print standard Supply reports.  
  

1. Click the Supply button to open the Supply module. 

2. On the Toolbar, click the Reports button to open the Supply Reports window.  

3. Click to select one of the following reports:  

• History (See Supply History Report on Page 52) 

• Inventory (See Inventory Reports on Page 53) 

• Reprint Waybill (See Reprinting a Waybill on Page 54) 

• Supplies Currently Issued To  

  

Supply History Report 

Follow the steps in this section to print a Supply History Report:  
  

1. On the Supply Reports window, click the History/Inventory option to display the 
History settings. 

 
  

2. If you want to print the report for a specific Resource, Location or Item, click the 
appropriate option under Specific. Then select the resource, location or item from 
the drop-down list. 
 
If you want to print the report for ALL Resources, Locations or Items, click the 
appropriate option under General. 



  

     
    Chapter 13:Supply Reports 

  

I-Suite Version 13.01.00 Supply 53 
  

3. To include the total history of the resource, location or item, click to check the 
Total History checkbox. 

4. To preview and then print the report, click the Preview button. When the Preview 
window displays, click the Print Report button. 
 
To print the report without first previewing it, click the Print button. 

5. When the Print window displays, click the Print button. 

  

Inventory Reports 

Follow the steps in this section to print Inventory reports:  
  

1. On the Supply Reports window, click the History/Inventory option to display the 
Inventory settings. 

 
  

2. Click one of the following options to print the identified report: 

• Current Inventory - This report is a listing of all of the supply items 
currently at the incident.  

• Adjustment History - This report contains a history of all Inventory 
Adjustments by NFES#.  

• Inventory - Manual Count - This report contains a list of the current 
inventory and inventory amounts defined in I-Suite. The report includes 
sections where you can write down the correct inventory if the actual 
inventory is different from what is defined in I-Suite. 

3. To preview and then print the report, click the Preview button. When the Preview 
window opens, click the Print Report button. 
 
To print the report without first previewing it, click the Print button. 

4. When the Print window opens, click the Print button. 
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Reprinting a Waybill 

Follow the steps in this section to reprint a Waybill: 
  

1. On the Supply Reports window, click the Reprint Waybill option to display the 
Reprint options. 

 
  

2. Click the Waybill you want to reprint under Reprint Waybill. 

3. Click the Preview button to view the Waybill in the Preview window. 

4. Click the Print Report button to print the Waybill from the Preview window. 
When the Print window displays, click the Print button. 

Supplies Currently Issued To 

Follow the steps in this section to print a list of supplies that are currently issued to one or more 
resources: 
  

1. Open the Supply-Issue or Issue Returns window. 

2. Click one or more resources in the Issue To grid or select a location from the 
Location drop-down list. 

3. Click the Issue Report button. 
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View Supply History 
The View Supply History function allows you to view a history of Supply transactions to occur for the 
selected incident. This includes issuing supplies, receiving supplies, transferring supplies, releasing 
supplies and returning supplies. You can view the history either by Resource and Location or by Supply 
Item. 
  
Follow the steps in this section to view a Supply History: 
  

1. Click the View History button in the Supply toolbar to display the Supply History 
window. 

 
  

2. To view the history by resources and location, click the Resource/Location 
button. 

3. To view the history by supply items, click the Supply Item button. 

4. Click the plus sign (+) next to a resource, location or a supply item to display a list 
of transactions. 

5. When you have finished viewing the history, click the Close button to return to the 
main Supply window. 
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Supply Report Descriptions 
The following Supply Reports are available in I-Suite: 
  

Supply History 

This report is a history of supplies that have been issued. You can print this report for a specific 
Resource, Location or Item or you can print it for all Resources, Locations or Items. 
  

Current Inventory 

This report is a listing of all of the items currently at the incident. Information about the following items is 
included in the report: 
  

• Received Items 

• Issued Items 

• Released Items 

• Returned Items 

• Items Transferred at the Incident 
  
The report identifies the count for each listed item. Trackable items with property numbers are listed with 
their assigned property number and item amount currently in the Supply tent. A Count Summary is 
included at the end of each NFES group where property numbers are assigned. Each property number 
has a count associated with it (1 or 0 depending on whether it is still in Supply or was issued or released). 
For example, if you have a count of 35 for NFES # 000343 and 12 were issued, the summary would be 
23. A Total displays at the end of the report. This is a total count for all of the items currently in Supply. 
  

Adjustment History 

This report contains a history of all Inventory Adjustments by NFES#. Each time a manual inventory is 
completed and adjustments made to the Supply System, a record is created that is included in the report. 
The report does not include active inventory information. It only contains a history of adjustments made 
during an inventory cycle. The information in the report includes: 
  

• NFES # 

• Property # 

• Date of Adjustment 

• Time of Adjustment 

• Amount of Adjustment 
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Inventory - Manual Count 

This report is necessary for completing an Inventory Manual Count Cycle. The report contains a list of the 
current inventory and inventory amounts. The report includes sections where you can write down the 
correct inventory if the actual inventory is different from what is defined in the Supply system. You can 
then use the report with the Inventory Form to make the necessary adjustments to the Supply Inventory 
system. Any changes made to the report are recorded and included in the Adjustment History report. The 
data you record in this report should be the actual count of the current inventory in stock as compared to 
the inventory defined in the Supply system. 
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Revision History 
Revision Date  Revision Summary  
2011-03-01 Revised instructions for the 11.01.00 version of I-Suite. 
2010-04-27 Revised instructions for the 10.01.00 version of I-Suite. 
2009-05-01 Revised instructions for the 9.01.00 version of I-Suite. 
2008-04-25 Revised instructions for the 8.01.00 version of I-Suite. 
2007-07-25 Revised instructions for the 7.01.05 version of I-Suite. 
2007-04-20 Revised instructions for the 7.01.00 version of I-Suite 
2006-12-04 Revised instructions by adding more detail and graphics. 
2006-06-12 Revised instructions for the 6.02 version of I-Suite. 
2006-05-01 Instructions for new features of the Supply module. 
2006-04-17 Instructions for new module of the new I-Suite 2006 application. 
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